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Lesson objectives

In this lesson, you’ll learn how to add, edit, and delete departments and to enter vendor 
information as necessary to customize QuickBooks Point of Sale for a client’s business.

After completing this lesson, you’ll be able to do the following:

 Create new departments

 Use different techniques to locate department records

 Edit department records

 Use department margins (or markups) to automatically set the price of new items

 Enter and edit vendor records

 Merge duplicate vendor records

 Locate vendor records

 Display a list of vouchers and purchase orders created for each vendor

 Print department and vendor lists

Learning resources

The following is a list of additional resources that you might find useful in increasing 
your understanding of the content covered in this lesson.

 Webinar (recorded): Setting up inventory

 Learning Center tutorial: How to add departments and vendors

Working with departments

In most retail businesses, related merchandise is grouped together into departments. A 
department is a manageable category created to aid in monitoring past performance and 
in making future buying decisions.

A well-designed department structure can save clients time and give them greater 
flexibility when conducting a physical inventory, marking down prices, printing tags, 
and selecting and summarizing data for reports.

Every item entered into inventory must be assigned to a department. QuickBooks POS 
then tracks the merchandise for each department as it is ordered, received, and sold. 
Grouping like items together in departments allows for more powerful reporting and 
analysis. Department records may be viewed in either List View or Form View.

To access the Department list:
 Select Department List from the Inventory menu.
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To add a new department:
 Select New Department from the Inventory menu.

Note: If a retailer is using Pro Multi-Store, its remote stores can view and print 
department records, but cannot add, edit, or delete these records.

Planning departments

The number of departments established for a business depends on how your client plans 
to evaluate the sales performance of merchandise and buying strategies. QuickBooks 
POS allows all merchandise to be entered into a single department, but you may want to 
consider the benefits of setting up a more detailed department structure.

A carefully planned department structure allows your client to view, edit, or run reports 
for selected groups of merchandise.

When planning departments, you may want to ask the client the following questions:

 How do you want to break out sales, merchandise and purchasing reports?

 Do you want to be able to filter your item list for purposes of changing prices, 
printing price tags, or conducting physical inventory counts by merchandise 
categories?

 Do you have categories of merchandise that are taxed differently or that you price 
differently than others?
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For example, if a client needs to be able to compare the performance of two groups of 
items, each group should be assigned to its own department. If purchasing dollars are 
budgeted differently for golf shoes than for running shoes, create separate departments 
for each of those shoe types.

QuickBooks Point of Sale can maintain a virtually unlimited number of departments. 
However, too many departments can result in too much detail on reports, which makes 
it difficult to get useful, consolidated data. We recommend that you define only as 
many departments as you need to effectively manage clients’ purchasing and reporting.

Understanding department names and codes

Department names are unique and specific to each client’s business. Name the 
departments in a consistent way that makes sense to the client and his or her employees. 
This makes the departments easier to remember and allows for intuitive filtering of the 
department list and reports.

Department codes provide a fast way to locate a department in the Find window by 
typing a few characters instead of the full department name. Department codes also 
enable the display of a short department identifier on item tags. While not required, it 
is often useful to define departments using a two or three-character code format, with 
each character representing a merchandise category. Planning the codes makes looking 
up items and creating reports easier.

Defining departments

It may be useful to define department names and codes similarly to facilitate easy entry. 
When defining departments, consider how they might be used when searching for 
department records or viewing the department list.

 Character 1—Use the first character of the department code to designates a major 
merchandise area. For example, in a shoe store, one major merchandise area might 
be men's shoes and another might be women's shoes. As an example, let's assign an 
M to designate the first character for the Men's Shoes department.

 Character 2—Use the second character to identify a less-broad category. The 
category of athletic shoes within men’s shoes is an example. Let's assign A to 
designate the men's athletic shoe category.
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In this example, the department code of MA would designate the department named 
Men’s Shoes: Athletic. You might then complete your department structure as follows.

For more detailed departments, add a third character representing an even more 
detailed merchandise category. For example, men’s athletic shoes might be further 
broken down into tennis shoes (MAT), running shoes (MAR), golf shoes (MAG), etc. 
Filtering a report or list by the MAR department would include only men's athletic 
running shoes.

Note: If items were imported from QuickBooks financial software, all of the imported 
items were put into a single department, named “QuickBooks financial 
software.” To make reports and purchasing records more meaningful and 
intuitive, define new department names to meet the client’s needs. Then assign 
the new departments to inventory. 

Using department information fields

When setting up departments, there are five fields to identify:

 Department code—a unique code (1-3 characters) to identify each department

 Department name—a descriptive name for the department

 Tax code—the default department tax code

 Margin %—the default profit margin for use with a pricing formula

 Markup %—an alternative way to display the desired profit margin by marking up 
from item cost

Department Name
Department Code
(printed on tags)

Men’s Shoes: Athletic MA

Men’s Shoes: Dress MD

Men’s Shoes: Casual MC

Women’s Shoes: Athletic WA

Women’s Shoes: Dress WD

Women’s Shoes: Casual WC
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For more detail on each of the five department fields, see the Chapter 10 in the User’s 
Guide.

Managing department records

This section describes the tasks available to manage department records, including 
creating, locating, and editing.

Creating a new department

Use the procedure here to create departments as needed to categorize the merchandise 
in inventory.

To create a new department:
1 Select New Department from the Inventory menu.

A blank department form is displayed.

2 Enter a Department Name.

3 Enter a Department code, if desired.

4 Enter information in other fields, as required.

5 Click Save.

Using copy to create a department record

If an existing department is similar to one you want to add, simply copy the 
department, and then edit the copy to reflect the new department information.

To create a department by copying an existing department record:
1 In the Department list, highlight the department record to be copied.

2 Click Copy Department from the window icon bar.

All the fields from the original department are copied to a new record.

3 Enter a unique Department name and modify the information to reflect the new 
department. 

4 Click Save.

Locating a department record

Locate individual department records in the department list by filtering, searching, 
sorting, or scrolling in the list. If you’re not sure how to perform these actions, refer to 
Chapter 10 of the User’s Guide for more information.



96

W o r k i n g  w i t h  d e p a r t m e n t s  a n d  v e n d o r s

Editing department records

You may edit department records as needed. However, please use caution when editing 
department names. Editing a department name in the department file does not change 
the department on item records in inventory. To correct inventory, you must edit the 
Department name for each item or style within that department to match the new 
name in the Department list.

Likewise, editing the margin %, markup %, and tax code fields does not effect these 
values for existing items in inventory. The new values are applied when new items are 
added to the department.

Changes to a department name are automatically reflected in other program areas and 
on reports.

To edit a department record:
1 Highlight the department record you want to modify.

2 Click Edit Department.

3 Modify the department fields as necessary. 

4 Click Save.

If you want to edit multiple departments right in the department list, select Turn List 
Edit On from the Edit menu, then navigate through the rows making your changes. 
Your changes are saved automatically when you navigate out of each row. Select Turn 
List Edit Off from the Edit menu when finished.

Deleting department records

Deleting a department record does not affect inventory or history documents. The 
department remains in place in both of those areas and reports can still be generated for 
the deleted department.

To delete a department record:
1 Highlight a department in the Department list.

2 Click Delete.

Using a pricing formula to set new item prices

Use a predefined pricing formula to calculate new item prices as they are added to 
inventory. When a new item is added and assigned to a department with a predefined 
margin, Point of Sale automatically computes the item’s regular sales price by applying 
the predefined margin to the item cost.

Note: Note that pricing formulas only affect the prices of new items added to 
inventory, they do not adjust prices of existing items when costs change. 
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If needed, edit the margin in inventory for individual items by entering a new margin 
in the Margin % field of individual item records. Or, if preferred, define a markup 
instead of a margin. Enter the markup from cost in the Markup % field in the 
department record. Point of Sale calculates and displays the margin.

While you can enter a Markup % to specify your desired profit margin, internally Point 
of Sale stores and uses the department margin value for its pricing calculations.

Both margin and markup must be whole numbers (i.e., no decimal places). When you 
enter a markup percentage, Point of Sale sets the margin to the nearest whole number 
that delivers your desired markup. However, to make sure both numbers are accurate, it 
then re-calculates the markup, rounds to the nearest whole number, and displays it. 
Thus, the number entered may be changed slightly.

For example, you enter a markup percentage of 40. Point of Sale calculates the nearest 
corresponding margin (whole number) to be 29. It then calculates backwards from the 
29 % margin and displays your markup as 41%.

To manually define prices in inventory, we recommend that you do not enter a margin 
or markup in the department record.

To define a default department margin or markup:
1 Display the department record.

2 Enter a value in either the Margin % field or the Markup% field.

Entering either results in the other being calculated and displayed by Point of Sale.

3 Click Save.

Repeat this process for each department for which you want to use a pricing formula on 
new items. Refer to Chapter 12 in the User’s Guide for more information about how 
pricing formulas are applied to new items.
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Working with vendors

Each vendor from whom your client purchases merchandise should be added to the 
Vendor list. A vendor entry is required on purchase orders and receiving vouchers. 

When vendors are associated with items in inventory and listed on purchasing 
documents, Point of Sale tracks and reports the merchandise by vendor as it is ordered, 
received, and sold. 

You can display the receiving history for a vendor instantly at any time. A vendor’s 
history provides summarized statistical data of the purchases and returns that your 
client has made for the vendor, as well as listings of all vouchers and non-deleted 
purchase orders. 

You can view vendor records in either List view or Form view.

To access the vendor list:
 Select Vendor List from the Purchasing menu.

To add a new vendor:
 Select New Vendor from the Purchasing menu.

If there were active vendor records in QuickBooks when your client began using Point 
of Sale, they were imported and added to the Point of Sale vendor list. Review and edit 
these vendor records as appropriate and complete other fields to fit the client’s needs. 

If the client is using Pro Multi-Store, the remote stores can view, but not add or edit 
vendors.

Using vendor information fields

There are over 15 fields that define each vendor:

 Vendor Code—Optional, alphanumeric code, up to three characters, identifying 
each vendor

 Company—Vendor company name

 Name Fields—Title, First, Last, Alt Contact

 Address Fields—Street, City, State, ZIP

 Phone Fields—Up to three telephone/FAX numbers can be entered in the Phone, 
Alt Phone, and Phone 2 fields

 Inactive—Use to hide unused vendors from the active vendor list and to stop 
exchanging the vendor’s information with QuickBooks

 Vendor Notes—Optional notes, such as shipping lead time, FOB shipping point, etc.
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 Account #—The client’s account number with the vendor

 Terms—Default payment terms for the vendor

 E-Mail—Vendor e-mail address

 Vendor Website

Using custom vendor fields (Pro)

Point of Sale allows you to define and use up to seven custom fields to record other 
vendor information important to a business. Once defined, these fields can be added to 
the Vendor list, used to filter the list and certain reports, or added to printed document 
templates.

To add a custom vendor field:
1 Click the Custom tab in the New or Edit Vendor window.
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2 Click Define Fields.

3 Select the checkbox next to the custom field to activate it.

4 Enter the names of the desired custom fields.

5 Click OK.

Managing vendor records

This section describes the tasks available to manage vendor records, including creating, 
locating, merging, and editing.

Creating a new vendor

Clients will want to add a new vendor the first time they purchase merchandise from 
that vendor.

To create a new vendor:
1 Select New Vendor from the Purchasing menu. 

A blank vendor form is displayed.

2 Enter vendor information in the fields. 

Note that Company is a required field. 

3 Click Save.

Note: QuickBooks financial software users: New vendor names should not duplicate a 
name already in the client’s financial software Vendor, Customer, Employee, or 
Other Names lists.

Using copy to create a vendor record

If an existing vendor is similar to one you want to add, simply copy the vendor, enter a 
new vendor name, and edit the other fields to reflect new vendor information.

1 Highlight the vendor in the Vendor list.
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2 Click Copy on the window icon bar. 

Most of the information from the original vendor is copied to a new record.

3 Assign a unique company name (required) and edit the fields to reflect the new 
vendor information.

4 Click Save.

Locating a vendor record 

Individual vendor records can be located in the vendor list by filtering, searching, 
sorting, or scrolling in the list. If you’re not sure how to perform these actions, refer to 
the User’s Guide or in-product Help.

Editing a vendor record

Changing a vendor name in the vendor file has no effect on inventory or receiving 
history. If a vendor name is changed, you must update item records for that vendor 
manually. In inventory, you must edit the vendor for each item purchased from the 
vendor.

To edit a vendor record:
1 Highlight the vendor record in the vendor list.

2 Click Edit.

3 Modify the vendor fields as needed. 

4 Click Save.

To edit multiple vendor records directly in the list:
1 Select Turn List Edit On from the Edit menu.

2 Navigate field-to-field within the vendor list to edit. 

Your changes are saved as you navigate out of a row.

3 Select Turn List Edit off from the Edit menu when finished.

Making a vendor inactive

Vendors in QuickBooks POS can be flagged as inactive, in which case they are not 
displayed when you filter the vendor list for active vendors.

This allows you to flag utilities and miscellaneous vendors (which may have been 
imported from QuickBooks) or any other vendor not currently used in QuickBooks POS 
as inactive, so they do not display on the active Vendor list.

To make a vendor inactive:
 Select the Inactive checkbox on the vendor record.

To make the vendor active again, clear the checkbox.
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To view inactive vendors:
 Filter the vendor list selecting the All Vendors filter or define a custom filter to 

display only inactive vendors.

Note: If you check the inactive flag when initially adding a vendor record in 
QuickBooks POS, that vendor is not sent to QuickBooks financial software. 
However, if you list the inactive vendor on a voucher, when that voucher is sent 
to QuickBooks, a record is created for that vendor in QuickBooks. From that 
point on, edits to the vendor are sent to QuickBooks unless the vendor is 
inactivated in both programs.

Merging duplicate vendors

Occasionally, you may end up with two records for the same vendor. This would most 
likely happen by entering the vendor twice with slightly different spellings of the name. 
Use the Merge Vendors feature to combine the receiving history of the duplicate 
vendors into a single record.

If your client also uses QuickBooks, he or she has the option of deleting or making the 
duplicate vendor inactive in QuickBooks so that it is not re-created in Point of Sale 
during the next data exchange.

To merge duplicate vendors:
1 In the Vendor list, highlight the vendor record you want to keep.

2 Select Merge Vendors from the I Want To menu.

The Merge Vendors window displays.
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3 From the drop-down list in the “Remove this duplicate” section, select the vendor 
you want to delete.

If you use QuickBooks, the name currently displayed in your QuickBooks vendor list 
is shown at the bottom of the window to help you verify you have the correct 
vendors selected.

4 If necessary, you can reverse positions of the vendors (which to keep and which to 
remove) by selecting the arrow button located between them.

5 Click Merge Vendors.

6 If prompted, specify whether you want to delete the duplicate from QuickBooks as 
well.

The deletion in QuickBooks occurs during the next Financial Exchange.

Note: If the vendor to be deleted is listed on any QuickBooks documents, QuickBooks 
will not allow the deletion. In this case the vendor is made inactive in 
QuickBooks so that it is not re-created in Point of Sale on the next Financial 
Exchange.

Deleting vendor records

Vendor records can be deleted from Point of Sale at any time.

If you delete a vendor, you will no longer have access to that vendor’s history, but the 
vendor remains listed on pending and history documents and may be included in 
reports that are generated from those documents.

If you are deleting a vendor because you have a duplicate, consider using the Merging 
Duplicate Vendors procedure instead. This combines the two vendor histories into one 
record and removes the duplicate.

To delete a vendor record:
1 Highlight or display the vendor record that you want to delete.

2 Click Delete.

If prompted, indicate whether you want to delete the vendor from QuickBooks as 
well.

Deleting a vendor in QuickBooks financial software

QuickBooks users that share vendor information should select to delete the vendor 
record in their financial software or it will be re-created in Point of Sale during the next 
Financial Exchange.

If the vendor is listed on documents in QuickBooks, the record cannot be deleted in that 
program so it is made inactive instead. This also prevents it from being re-created on the 
next exchange.
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If you delete a vendor, but later list that vendor on a receiving voucher (by referencing a 
PO listing the vendor), the vendor will be re-created in both Point of Sale and 
QuickBooks with the following Financial Exchanges.

Using vendor payment terms

Specify default payment terms in the Terms field of the vendor record. These terms are 
then suggested on purchase orders and vouchers that are created for the vendor.

If exchanging data with QuickBooks and vendors were imported from QuickBooks, the 
Terms field is populated with the default terms that were defined for the vendor in 
QuickBooks. If the default terms in either program are edited, they are sent to the other 
and become the new default terms in both.

Terms on individual POs and vouchers may be modified as they are created. Terms are 
sent with the voucher to QuickBooks and added to the QuickBooks Terms list. The 
terms entered on the voucher do not overwrite the default terms in either program.

To define terms for a vendor:
1 Display the vendor record in Form View.

2 Click Edit Terms.

 The Terms dialog appears.

3 Enter term information in the fields.

The entries shown in this example would result in terms of 5% 10 Net 30 being 
applied on documents.

4 Click OK.

Note: Vendor terms are automatically applied to purchase orders and vouchers. 

Viewing a vendor’s history

Vendor history allows you to view summarized statistical data for the merchandise that 
has been purchased and returned from/to the vendor, as well as displaying a list of 
former vouchers and non-deleted purchase orders.
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To access vendor history:
1 Highlight a vendor record in the list.

2 Click Collapse to access the Vendor Information Panel which displays the vendor 
history.

OR

View the vendor record in Form view and click the History tab.

Note: You can “drill-down” into a vendor’s history to see document item detail or to 
view the entire document in a separate window. Select the plus sign on a line to 
expand the document and view item details. When the QuickZoom icon is 
displayed, double-click to open the document.

Vendor history is refreshed each time you access the Vendor list. (If documents are 
created while the vendor list window is open, pressing F5 allows you to refresh the 
history without having to close and reopen the window.) You can also drag-and-drop 
column headers or separators to rearrange and resize columns respectively.

If you delete purchase orders once they are filled, the deleted purchase orders are no 
longer displayed on the Vendor History window, and their information is not included 
in the summarized statistical information. However, the receipt of the merchandise on 
deleted purchase orders is reflected in the receiving vouchers and receiving information 
in the window.

(Pro Multi-Store) Remote stores can only view receiving vouchers and POs created for 
the vendors at the local store.
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Viewing or copying a vendor document

You cannot edit the information displayed on the Vendor History window, but you can 
copy the documents in the list to quickly create new vouchers or purchase orders. This 
feature is handy if you frequently order the same items in the same quantities from a 
vendor.

To view or copy a vendor document:
1 Highlight a document on the Vendor History window.

2 Use QuickZoom to display the document, or select Go To Document from the I 
Want To menu in the history part of the screen on the right side of the report.

With the document displayed, you can copy, edit (subject to normal editing 
guidelines), or reverse it as needed.

Note: If you have a voucher or purchase order window open when you come to 
Vendor History, you must switch back to the open document window and 
cancel or complete it before you can copy from history to another new 
document of the same type. Only one of any document type may be open at a 
time.

Using multiple vendors for an item (Pro)

Point of Sale allows users to track up to five separate vendors for any inventory item, 
each with a unique UPC, Alternate Lookup, and order cost. This allows them to 
purchase the same item from any of several vendors as availability and costs change.

To use the multiple vendor feature:
1 Add each vendor to Point of Sale.

2 Add the item to inventory, assigning one primary vendor in the Vendor field.

3 Enter the UPC, Order Cost, and Alternate Lookup for the primary vendor in the 
appropriate fields in the item record.

4 Click the Additional Info tab.
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5 Click Add/Edit Alternate Vendors.

The Add/Edit Alternate Vendors window displays.

6 Enter a Vendor Name, UPC, Order Cost, and Alternate Lookup for up to four 
alternate vendors of the item.

7 Click Close when finished.

8 Click Save.

Averaged inventory cost, on-hand quantities, and prices are combined for an item once 
received into inventory, no matter how many vendors the item may have been 
purchased from. However, reports showing merchandise on order, on hand, or received, 
if filtered by vendor, are broken down by each vendor from which you have purchased 
an item. Each vendor's record has the vendor history for the specific purchases made 
with that vendor. 
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Using multiple vendors on documents

When you are creating purchase orders or receiving vouchers, enter the preferred 
vendor or one of the alternate vendors. You can then list the items to be purchased using 
the specific vendor’s UPC or Alternate Lookup values. The appropriate order cost will be 
suggested on the document for the vendor entered.

When creating other document types, scanning or entering any of the defined UPCs or 
Alternate Lookups for the item lists the item on the document.

Printing department or vendor lists

To print a department or vendor list:
1 If you want to print a group of records, filter the list to display only those.

To print the entire list, make sure the list filter is set to display all records.

You can also multi-select records from the list using standard Windows selection 
procedures (Ctrl+A to select all, Shift+Click first and then last to select all in 
between, or Ctrl+Click each to select non-contiguous).

2 Select Print from the File menu.

3 Follow the prompts in the print options dialog.

You can now export to Excel directly from the Point of Sale lists. Select “Export to Excel” 
from the I Want To menu.
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On your own exercises

On your own exercises are designed to provide you with an opportunity to practice 
some of the tasks and procedures covered in the lessons. Try the procedures here to help 
familiarize yourself with the software.

Before you begin, see “Working in Practice Mode” on page 43 for more information 
about the exercises and accessing Practice Mode.

Note: Be sure you are working on practice company data in Practice Mode when 
completing these exercises.

Scenario

Joe, the manager of Al’s Sport Hut, has decided to start carrying duffel bags as part of his 
inventory. Based on his inventory structure, he wants to create a new department for 
duffel bags so he has more detailed sales records and a new vendor, from whom he will 
source the bags.

Follow the steps below to set up the new department and vendor, and complete some 
additional tasks.

Create the new department:
1 From the Inventory menu, select New Department.

2 Enter the following information:

 Department name - ACCESSORIES: DUFFEL BAGS

 Department code - AD

 Tax Code - State

 Margin % - 50

3 Click Save.
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Joe met the sales representative for the new vendor at a sporting goods trade show last 
month and has decided to use them as the source for the bags.

Add the new vendor:
1 From the Purchasing menu, select New Vendor.

2 Enter the following information:

 Company - SPORTSTORE, INC.

 Vendor Code - SSI

 Contact - CHRIS PEPPER

 Address - 524 S. MAIN STREET, MIDDLEFIELD, CA 94482

 Phone - 650-555-4890

 Account # - 24-98456

3 Click Save.
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Review questions
1 If items from QuickBooks financial software are imported into QuickBooks POS, all 

of the imported items are put into a single department with what name?

_______________________________________

2 How do you define the default sales tax codes for inventory items?

_______________________________________

3 If information for departments is very similar, how can you speed up data entry?

_______________________________________

4 Which of the following is required when setting up a new department?

a Department Code

b Department Name

c Tax Code

5 True or false: Editing vendor names does not affect previous transactions involving 
that vendor.

_______________________________________

6 True or false: Only one vendor can be tracked for any item in QuickBooks POS when 
using the Pro or Pro Multi-store level.

_______________________________________

7 Which is the best way to deal with duplicate vendors?

a Make one of the vendor records inactive

b Merge the vendor records

c Delete one of the vendor records

d None of the above

Answers to questions are located on the following page.
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Answer key
1 QuickBooks financial software

2 By entering the tax code in the record for the department with which the item is 
associated. You can change the tax code in individual item records.

3 Copy existing department records to use as the starting point for new department 
records. You only need to edit the fields that are different.

4 B

5 True. 

Changing a vendor name in the vendor file has no effect on inventory or receiving 
history. If a vendor name is changed, item records for that vendor must be updated.

6 False. 

Multiple vendors, with unique costs and UPC numbers, can be tracked for any item.

7 B
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Notes

Use this section to keep a list of any questions you have as you’re working through the 
lesson. Keep this page nearby and ask the questions when you attend the live webinar 
sessions.
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